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Introduction

This document provides general guidelines for typical office users that are connecting
PColP zero clients and software clients to VMware View 4 virtual desktops over remote
access WAN networks. The PColP protocol enables the broadest range of network
support to handle any enterprise user demands. Network requirements can vary greatly
depending on the network parameters, application graphical requirements and user
demands. As such, this document is not intended to replace more detailed documentation
provided by VMware and Teradici.

There are a number of tuning options for optimizing performance on a WAN including:
+  Adjust the Windows Experience (Section 2)

+  Ensure sufficient minimum bandwidth for PColP packets (Section 3.2.1)

«  Minimize packet buffering for PColP packets through the network (Section 3.2.2)

- Ensure an appropriate queuing/priority configuration in the switch/router (Section
3.2.2)

+ Adjust the VMware View settings per user:
o Image quality (Section 4.1)
o  Maximum display frame rate (Section 4.1)
o Maximum bandwidth (Section 4.2)

+ Follow key WAN testing guidelines (Section 5)

Detailed information on configuring VMware View or PColP zero clients and software
clients can be found in the following documents:

+ Using PColP Zero Clients with VMware View 4 (TERA0904005). To get this
document, contact your Teradici Sales Director.

«  Getting Started with VMware View (EN-000276-00)
+  VMware View PColP Network Sizing Guide

« Additional VMware View documents

TER1007002 Issue 2
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1 System Requirements

To connect a PColP client to VMware View 4 you must have:

+ A functional VMware View environment using the latest VMware View release

4.0.2, 4.5, or newer.

+ Virtual desktops with Microsoft Windows XP, Vista, or Windows 7 installed.

« A PColIP zero client with the latest 3.x firmware installed. For a list of VMware
Ready PColP zero clients, see http://www.teradici.com/pcoip/pcoip-
products/vmware-view-clients.php

« A functional remote access network environment between the datacenter office and

remote sites.

Datacenter network

virtual desktops

VMware View 4
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2 Optimizing Windows Experience Settings

There are a number of visual settings in Windows that require additional bandwidth to
deliver. An initial step in optimizing for WAN networks is to consider turning these
features off to significantly reduce in the average and peak network bandwidth required.

2.1 Windows 7 Visual Settings Optimization

Warning: This batch file should be run by an experience administrator to understand the
change made by using the script.

See the VMware View Optimization Guide for Windows 7.

To optimize the Visual Settings:
1. Save the Commands.txt as Commands.bat.

2. Right-click and then select run as administrator.

2.2 Windows XP Visual Settings Optimization

+ Set Visual affects to best performance:
1. Right-click on My Computer, and then select Properties.
2. From the Advanced tab, click Settings.
3. Select the Adjust for best performance option.
- Remove Desktop wall paper:
1. From the Start menu, click Run.
2. Enter gpedit.msc to display the Group Policy window.

3. From the Computer Configuration folder, select Administrative Templates
>> Windows Components >> Terminal Services >> Enforce Removal of
Remote Desktop Wallpaper.

4. Ensure this is set to Enabled, and then click OK.
+ Enable Blank Screensaver:
1. From the Start menu, click Run.
2. Enter gpedit.msc to display the Group Policy window.

3. From the User Configuration folder, select Administrative Templates >>
Control Panel >> Display >> Screen Saver.

The Screen Saver dialog appears.
4. Ensure this is set to Enabled.

5. Click Next Setting to display the Screen Save executable name Properties
dialog. Set the Screen Saver executable name to scrusave.scr

TER1007002 Issue 2
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Enable Classic Start Menu:

1. Right-click on the Taskbar and then select Properties.

oW

From the Start Menu tab, sclect the Classic Start Menu.
Click Apply, and then click Customize.

Scroll to the bottom of the Advanced Start menu options, and then check the

box for Show Small Icons in Start menu.

5. Uncheck the Use Personalized Menus box, click OK, and then click OK.

Disable additional fading:

1. Right-click on the Desktop, and then select properties.

2. From the Appearance tab, click Effects.
3. Uncheck the boxes, click OK, and then click OK.

Change System Icon and Text Settings:

1. From the Control Panel, sclect the View menu.

2. Select Toolbars >> Customize, and then set the Text options to No text labels
and set Icon options to Small icons.

Click Close.

Select Folder Options, and then select the View tab.

3
4. From the Control Panel, select the Tools menu.
5
6

Check or uncheck the boxes as shown in the following two screenshots.

Folder options = OE]
General View I File Typesl Offline Filesl

Folder views
You can apply the view [such as Details or Tiles) that
I’ you are using for this folder to all folders.

Apply to &l Folders I

Reset All Folders I

I
General View I File Types | Offiine Files |
[~ Folder views

‘You can apply the view [such as Details or Tiles) that
‘ you are using for this folder to all folders.

Apply to Al Folders I Reset &ll Folders |

Advanced settings:

Advanced settings:

[ Display file size information in folder tips ;‘

Display simple folder view in Explorer's Folders list

[ Display the contents of system folders

Display the full path in the address bar

Display the full path in the title bar

Do not cache thumbnails

i} Hidden files and folders
QO Do not show hidden files and folders
® Show hidden files and folders

[ Hide extensions for known file types

Hide protected operating system files (Recommended)

[0 Launch folder windows in a separate process i

Restore Defaults

[0 Launch folder windows in a separate process ;I
) Managing pairs of Web pages and folders
® Show and manage the pair as a single file
QO Show both parts and manage them individually
QO Show both parts but manage as a single file
Remember each folder's view settings
[ Restore previous folder windows at logon
[ Show Control Panel in My Computer
Show encrypted or compressed NTFS files in color
[ Show pop-up description for folder and desktop items
Use simple file sharing (Recommended)

v

Restore Defaults

Figure 2-1System Icon and Text Changes

7. Click Apply.
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3  Network Planning Considerations

The PColP protocol provides a real-time delivery of a rich user desktop experience using
UDP. To ensure a responsive desktop, PColP protocol must be deployed across a
properly architected network infrastructure that meets bandwidth, latency, jitter, and
packet loss requirements. Since every customer/end user perception is different, when
you plan your network consider:

«  Graphically intensity of the typical user (e.g., forms pages or 3D viewer).
- Importance of image quality to user (e.g., administration or artist).
«  Amount of interactivity vs. static viewing.

+ Increased bandwidth may be required to satisfy more demanding users.

3.1 Network Bandwidth Planning — Basic Office
Productivity Desktops

Determine minimum bandwidth required for simultaneous access for typical office
productivity users.

When you consider your network bandwith, plan for:

« 200 to 250 kbps average bandwidth for a basic office productivity desktop: typical
office, applications with no video, no 3D graphics, and the default Windows and
VMware View settings.

« 80 to 150 kbps average bandwidth for a basic office productivity desktop: typical
office, applications with no video, no 3D graphics, with Windows experience
(Section 2) and VMware View session variable optimization (Section 4)

+ 500 kbps to 1 Mbps minimum peak bandwidth to provide headroom for bursts of
display changes. In general, size you network using the average bandwidth, but
consider peak bandwidth to accommodate bursts of imaging traffic associated with
large screen changes.

« 1 Mbps per simultaneous user running 480p video.

« Less than 80% network utilization.

Note: 80 to 250 kbps per user is based on the assumption that all users are operating continuously
and performing similar tasks over an 8 to 10 hour day. Situations may vary in that some users may
be fairly inactive and consuming almost no bandwidth allowing more users per link. As such, these
guidelines are intended to provide a starting point for more detailed bandwidth planning and testing.

3.1.1 1.5 Mbps T1 Example for a Basic Microsoft Office
Desktop

- Basic office productivity applications, no video, no 3D graphics, and
keyboard/mouse USB traffic.
+  Bandwidth required - (250Kbps/0.80) * 5 = 1.5Mbps.

« Result: Between 3 to 5 concurrent users per T1 line.

TER1007002 Issue 2
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Note: You may require VMware View and Windows optimization to achieve this user density.

3.1.2 10 Mbps Example for a Microsoft Office Desktop
with Occasional Multimedia

Scenario 1

-+  Basic office productivity applications, up to a single user watching occasional 480p
video, no 3D graphics and keyboard/mouse USB traffic. Desktop optimizations
including:

o  Windows experience settings optimized
o Maximum bandwidth PColPMaxLinkRate GPO set to 5 Mbps

o  Maximum initial image quality PColPImagingMaximumInitiallmageQuality
GPO set to 70

o Frame rate limit registry key set to 12 fps
«  Bandwidth required - (250 Kbps/0.80) * 28 = 8.75 Mbps.

- Bandwidth required - (1 Mbps/0.80) * 1 = 1.25 Mbps (for a single user watching
video at any given time)

Result: Up to 28 concurrent users per 10 Mbps line.

Scenario 2

-+ Basic office productivity applications, up to a single user watching occasional 480p
video, no 3D graphics and keyboard/mouse USB traffic. Desktop optimizations
including:

o  Windows experience settings optimized
o Maximum bandwidth PColPMaxLinkRate GPO set to 3 Mbps

o  Maximum initial image quality PColPImagingMaximumInitiallmageQuality
GPO set to 70

o Frame rate limit registry key set to 8 fps
+  Bandwidth required - (150 Kbps/0.80) * 46 = 7.5 Mbps.

- Bandwidth required - (1 Mbps/0.80) * 1 =1.25 Mbps (for a single user watching
video at any given time)

Result: Up to 46 concurrent users per 10 Mbps line.

Note: You may need additional VMware View and Windows optimization to achieve this user
density.

3.2 Network Configuration Considerations

To ensure a successful VMware View deployment, perform a network assessment to
determine proper configuration to support the necessary bandwidth while meeting
latency, jitter and packet loss requirements.

TER1007002 Issue 2
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3.2.1

3.2.2

Network Bandwidth

«  Ensure a full-duplex end-to-end network link is used.

Note: Older switches may incorrectly default to half duplex when connected to a link with auto-
negotiation. In this case, you must explicitly set the switch link to full duplex.

«  Confirm network connectivity and that sufficient bandwidth is available between the
VMware View server, VMware View manager, and the PColP client.

«  Ensure that PColP packets are not fragmented at any point in the network path.

o  Check that the MTU in the switches/routers in the network path is not below the
PColP packet MTU size. Consider increasing the switch/router MTU or reduce
the PColP packet MTU via the PColPMtuSize GPO — set to a value between
500-1500 bytes (default is 1400).

Note: Consider increasing the switch/router MTU before reducing the PColP packet MTU as a
lower MTU size can impact desktop performance.

+  Consider segmenting PColP traffic via IP QoS DSCP or a layer 2 CoS or virtual
LAN (VLAN).

« Ifa VPN is used, confirm that UDP traffic is supported.

o Do not route PColP traffic through TCP-based SSL tunnels.

o Use a VPN-less solution such as a security gateway, or use IPSEC or DTLS-
enabled SSL solutions.

o See Knowledge Base item #312 on the techsupport.teradici.com for information
on the Security Gateway development.

Network Latency and Jitter

«  Ensure that the round trip network latency is less than 250 ms for VMware View 4.x.

«  Perform a thorough assessment of active application traffic across the end-to-end
network to ensure that there is sufficient minimum bandwidth available for PColP
traffic even with network congestion.

Network congestion and traffic shaping with deep packet buffers can cause high
packet latency, which can be considered as lost packets to PColP protocol.

+  Ensure that the buffers in routers/switches are set to minimize latency (e.g., to absorb
50 ms to 100 ms of PColP packet traffic).

o If aservice provider cannot reduce the buffer depths in all routers in the network
path, consider applying traffic shaping policies in the Customer Edge (CE)
router, or Service provider Edge (PE) router.

+  Allow PColP traffic to burst when network bandwidth is available (e.g., do not set a
hard limit on PColP traffic as a % of the link rate).

- Ensure sufficient priority for PColP traffic while considering the real-time nature of
the protocol. Consider options such as Class-based Weighted Fair Queuing
(CBWFQ).

o Assign a priority to PColP traffic that is above standard TCP traffic, but below
Voice-over-IP (VOIP) protocol.

TER1007002 Issue 2
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o Ensure guaranteed network bandwidth for PColP traffic during congestion. In
general, set PColP traffic to have 80% of the remaining bandwidth after the
higher priority traffic is allocated. For example, consider a network that
guarantees 20% of a link bandwidth for critical traffic such as VolP, PColP
should be set to receive 80% of the remaining bandwidth, or 64%. This lets other
protocols, such as file transfers or web traffic, transfer some traffic without
starving the PColP sessions.

o Iftraffic shapers are being used, use them in conjunction with a scheduling
queue, and assign high priority to this queue based on the CoS value set for
PColP traffic. This is CBWFQ.

To reduce packet latency further, configure priority-queuing for low-latency traffic
also called low-latency queuing. It can be configured with class of service to match
and mark the high-priority traffic and then send it to a low-latency queue, On Cisco
devices, network managers should try different queue-limits to ensure there are no
tail-drops on PColP packets. This gives high priority to low-latency traffic. This is a
version of policy-based routing available on most routers.

Configure congestion avoidance policies to use weighted random early detection
(WRED) for PColP traffic.

Ensure that the ESX virtual switch traffic shaper is turned off.

Note: Periodic excessive latency is an indication that traffic shaping with deep packet buffers is
impacting PColP packet delivery during periods of congestion.

3.2.3 Network Packet Loss

PColP protocol is tolerant to a reasonable amount of packet loss. Since PColP traffic
is a real-time delivery of a rich user desktop experience, packet loss should be
minimized where possible.

There are multiple potential sources of packet loss in a VMware View environment
including:

o Network congestion triggering congestion avoidance algorithms. While this is
expected behavior when congestion avoidance policies are configured, excessive
packet loss due to congestion is an indication that additional optimization is
required to increase bandwidth available or to reduce PColP traffic.

o PColP packets that arrive with a high latency due to network congestion may be
considered as lost packets by VMware View.

o  PColP packets that arrive sufficiently out of order may be considered as lost
packets by VMware View. Be sure to minimize packet re-ordering in the
network.

Note: If network logs show no packet loss but VMware View and/or PColP zero client logs show
packet loss, this indicates packets with high latency, or sufficiently out-of-order packets being
considered as lost.

TER1007002 Issue 2
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Description Resolution Options to Consider
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(e.g. WRED being triggered)
Packets considered lost by VMware View due
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to high latency packet delivery
Packets considered lost by VMware View due v v v
to sufficiently out-of-order packets

Table 3-1 Resolution Options when Experiencing Significant Packet Loss for a VMware View
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4 VMware View Manager Settings for the
Desktop

Administrative templates can be used to customize virtual desktop settings via PColP
session variables. This is done using the PCoIP.ADM template with the Microsoft GPO
editor.

«  PColIP.ADM file location: The PCoIP.ADM file is found on the VMware View
Connection Server in C:\Program Files\VMware\VMware
View\Server\Extras\GroupPolicyFiles\pcoip.adm. For isolated changes to a specific
VM, copy this file to C:\windows\inf within the Windows VM and implement using
a group policy editor. For larger environments, apply the pcoip.adm to an OU or
apply the setting to the template prior to deployment.

« Importing the ADM file:
1. Copy the PColP.ADM to the Windows VM.

2. From the Start menu, click Run, and then enter gpedit.msc. The Group Policy
window appears.

3. Right-click on Administrative Templates, and then select Add/Remove
Templates.

= Local Computer Policy @8 Administrative Templates
= @ Computer Configuration

g ngtware Settnlngs Select an item to view its description.
[+~ Windows Settings
- m-3
= s& User Cot I dd/Remove Templates...
~ A
6L Soft — ayl Tasks 3
[+-[__] Wine
(] Adm  View >

Figure 4-1 Importing the PColP.ADM file
4. Select Add and choose the PCoIP.ADM in C:\window\inf.

5. Click Close.

GPO options for PColP session variables appear.

E] ,——' aift;vare :etttt.lngs Configure the maximum PCoIP Settin State
E ﬂ Adln loyvts 5 "?rgs Jat session bandwidth Q Configure the maximum PCoIP session bandwidth Mot configured
Administrative .emp a»es ) =4 Configure the PColP session M Mot configured
[=1-[_] PColIP Session Variables Display Properties &, 3 . . )

23 Overridable Administrator Defaits (% Configure the PColP session bandwidth floor Mot configured
(] Mot Overridable Administrator Settings | Description: {4 Enable/disable audio in the PColP session Mot configured
(2 Windows Components This policy constrains the peak bandwidth {4 Configure PCoIP session encryption algorithms Mot configured
; - P used by the PColP session. Leaving this @ Confi PColP USE allowed and unallowed devi I Not configured

|58 User Configuration policy Not Configured means no EN Configure PCol allowed and unallowed device rules ot configure:
(- (2] Software Settings bandwidth constraints, otherwise the g Configure the TCP port the PCoIP host binds and listens to Mot configured
-] Windows Settings value is the maximum bandwidth in (M Configure the Server PCoIP LUDP port Not configured
(L Administrative Templates Idobits per second. =4 Configure the Client PCoIP UDP port Mot configured
(= Configure PCoIP virtual channels Mot configured
{4 Configure PCoIP image quality levels Mot configured

=4 Enable Right SHIFT behavior when a PColIP client is connected. Mot configures
; ble Righ beh he l d figured
{4 Enable the FIPS 140-2 approved mode of operation. Mot configured
{4 Disallow cansole input behavior when a PColP client is connected. Mot configured
{4 Turn on PColP user default input language synchronization. Mot configured
{4 Use alternate key for sending Secure Attention Sequence Mot configured

Figure 4-2 Setting PColP Session Variables via Microsoft GPO Editor
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4.1 Display/Imaging

Warning: Teradici has carefully selected the default values and recommends that you do
not change these settings unless you have carefully determined the overall effect to be
beneficial.

For optional optimization, adjust the image quality settings:

PColPImagingMinimumlImageQuality GPO: Set to a value between 30 and 100
(default is 50). In a limited bandwidth scenario this setting allows configuring the
preference between:

o A higher frame rate (lower value) for smooth motion, with lower image quality.

o A higher image quality (higher value) for crisp imaging, with less smooth image
motion.

PColPImagingMaximumlInitiallmageQuality GPO: Set to a value between 30 and
100 (default is 90). In a limited bandwidth scenario, this setting lets you configure the
preference between:

o A higher initial image quality, with larger peaks in bandwidth during large screen
changes.

o A lower initial image quality, with smaller peaks in bandwidth during large
screen changes.

Note: If used, consider adjusting the maximum imaging quality before applying a bandwidth limit or
adjusting the minimum image quality.

Note: The "Minimum Image Quality" must be set to a value below the "Maximum Initial Quality".

PColP.maximum_frame rate: The default is 30 frames per second (fps). In a limited
bandwidth scenario, this setting allows configuring the preference between:

o A higher frame rate for smooth display imaging motion, with possible increased
average network bandwidth.

o A lower frame rate for a lower average network bandwidth, with less smooth
image motion.

o Ifused, create a DWORD value in decimal under this registry key:
HKEY LOCAL_ MACHINE\SOFTWARE\Policies\Teradici\PColIP\pcoip admi
n_defaults\pcoip.maximum_frame rate setting up to 30 in Hz (default is 30). A
limit of 8 to 12 fps should be acceptable for basic office users.

4.1.1 Example: Network Congestion Causes Occasional
Degraded User Experience

Scenario:

TER1007002 Issue 2

Basic office productivity applications, no video, no 3D graphics.
T1 line with four active users.

An analysis of the link shows periodic spikes in bandwidth that consume the
available link bandwidth, or the bandwidth assigned to PColP traffic. Further analysis
shows that the network traffic during these spikes is roughly distributed across all
active users.

Users notice a momentary degradation in their desktop experience.
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4.2

Resolution:
+  Set the Windows XP Visual settings for best performance as described in Section 2.

« Reduce the maximum initial image quality
PColPImagingMaximumlInitiallmageQuality = 70

Result:

- Users maintain an acceptable desktop experience even during spikes in bandwidth.

Network

Warning: PColP protocol is architected to take advantage of available network bandwidth
and fairly share bandwidth across active users on a link. As such, Teradici recommends
that you do not change this setting unless you have carefully determined the overall effect
to be beneficial.

Optional optimization:
+  Set the ceiling on the bandwidth an individual user session can consume (in Kbps)

+  Be careful not to set a maximum bandwidth limit too low such that individual
sessions cannot take advantage of additional link bandwidth when available. In this
case, consider increasing link bandwidth at network congestion point(s).

« PColPMaxLinkRate GPO: Set to the desired maximum PColP session bandwidth in
kilobits per second (e.g., 1000 = 1000 Kbps = 1 Mbps). Default is 1 Gbps, 0 =no
bandwidth constraints.

Note: If used, this setting must be configured for users that share a particular network link.
Optional optimization:

«  Set a floor on the bandwidth an individual user session will try to consume under
load (in Kbps). This GPO is available in VMware View 4.5 or newer.

Warning: PColP protocol is architected to take advantage of available network bandwidth
and fairly share bandwidth across active users on a link. As such, Teradici recommends
that you do not change this setting unless you have carefully determined the overall effect
to be beneficial.

«  Be careful to ensure that there is sufficient network bandwidth across the network
patch to support all users on that network simultaneously transmitting at the
bandwidth floor.

+  PColPBandwidthFloor GPO: Set to the desired target PColP session floor
bandwidth in kilobits per second (e.g., 350 = 350kbps). The value range is from 0 to
100,000 kbps (0-100 Mbps). Default is 0 = no bandwidth constraints.

Note: The actual bandwidth is below the configured bandwidth floor target if the user session does
not require the additional bandwidth.
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4.2.1 Example: Network Congestion from a Small
Number of Users Cause Degraded User Experience

Scenario:
- Basic office productivity applications, no video, no 3D graphics.
« 6 Mbps link with 20 active users.

« An analysis of the link shows periodic spikes in bandwidth that consume the
available link bandwidth or the bandwidth assigned to PColP traffic. Further analysis
shows that one or two users are consuming 3 to 4 Mbps during the degradation
(possible the users are watching video even though that was not planned for).

«  The remaining users notice degradation in their desktop experience.
Resolution Options:
+  Set the Windows XP Visual settings for best performance as described in Section 2.

+  Set the maximum PColP bandwidth per user via the PCOIPMaxLinkRate. Since only
one or two users spike at a given time, the bandwidth is set at 1000 kbps. This must
be set for all users on the link.

+  Set the PColP bandwidth floor per user via the PColPBandwidthFloor GPO. A floor
of 240 kbps is set to ensure a baseline performance for the users during a congestion
event.

- If after making this setting the users still notice a momentary degradation in their
desktop experience, consider adjusting the image quality settings — reduce the
maximum initial image quality PColPImagingMaximumlInitiallmageQuality = 70
increasing the minimum image quality PColPImagingMinimumImageQuality = 60.

Result:

Users maintain an acceptable desktop experience even when a few users spike in
bandwidth.

4.2.2 Example: Optimizing for Increased User Density on
WAN Network Links

Scenario:

+ Basic task worker/call center applications, no video, no 3D graphics. Low average
bandwidth is a higher priority than user experience.

« 1.5 Mbps link with >5 active users.
Resolution Options:
«  Set the Windows XP Visual settings for best performance as described in Section 2.

«  Set the maximum PColP bandwidth per user using the PCOIPMaxLinkRate. The
actual setting depends on the number of users targeted for the link. This must be set
for all users on the link.

« Reduce the maximum initial image quality
PColPImagingMaximumlInitiallmageQuality = 70, and the minimum image quality
PColPImagingMinimumlImageQuality = 40.
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+ Reduce the PColP.maximum_frame rate = 8 fps.

+ If the average bandwidth is not sufficiently reduced, you can use even lower settings
for the bandwidth limit and image quality.

Result:

More than five users can be active simultaneously on a T1 WAN link.
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5

5.1

WAN Connected Virtual Desktop Testing
Guidelines

Test real workloads with multiple users actively sharing the link. Key considerations
include:

+  Single user bandwidth tests are invalid since PColP protocol will take as much
bandwidth as possible unless constrained by the network, or by configuration. When
constrained, the PColIP protocol fairly shares bandwidth with other PColP protocol
users.

« Do not try to simulate desktop performance by limiting a single session. This is also
an invalid test.

« Do not rely on video playback to be representative of real-application user
performance

«  Test real web sites that users go to, not just sites that support windows media since
MMR improves video in just that case.

Note: Do not use random packet loss to emulate network loss. Random packet loss is not
representative of real network loss and results in PColP protocol using the minimum quality and
performance.

Free WAN emulation tools can randomly drop packets to emulate network packet loss.
However, in real networks random packet loss is rare and due to poor network link
quality which is typically repaired by Service Providers when it occurs. PColP protocol
adapts to the packet loss to reduce the network load, however the random loss algorithm
causes PColP protocol to continually lower the display quality and frame rates until the
minimum quality floor is hit.

A common cause of packet loss is network congestion (or the result of congestion
avoidance algorithms being triggered) which results in periodic and sequential packets
lost. This loss goes away when the congestion is alleviated. More sophisticated WAN
emulation tools incorporate more intelligent packet loss algorithms. PColP protocol
adapts to the packet loss to reduce the network load to help alleviate the network
congestion causing the loss.

X86 and/or Thin Client Considerations

«  Multi-media redirection can make certain video's look better on an appropriately
powerful client, but the same performance improvement is not realized when using
Office applications or scrolling PDF's etc. Turn off MMR to see how the client
appears with new media that is not supported by redirection (e.g., HTMLS5, Google
WebM).

«  Test with the client devices you plan to purchase.

For more detailed information on VMware View 4 to PColP zero client operation, see the
online knowledge base or submit a support request at techsupport.teradici.com.
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